Modbus and ION Technology

Modicon Modbus™ is a communications protocol widely used in process control industries such as manufacturing. PowerLogic™ ION™ meters are compatible with Modbus networks as both slaves and masters, and can communicate easily with ION Enterprise, ION Setup or third-party software.

This technical note describes the Modbus protocol in general, how to use ION meters and software with Modbus devices, and how ION meters fit into a Modbus network.

In This Document

- Introduction ................................................................. 2
  The Modbus Message .................................................. 3
  Modbus Maps for ION Meters ........................................ 5
- ION and Modbus in Networks .......................................... 6
  Scenario 1: ION Meters in a Modbus Network ....................... 6
  Scenario 2: Modbus Devices in an ION Enterprise Network .......... 7
  Scenario 3: ION Meter as Modbus Master ........................... 8
  Scenario 4: EtherGate and Modbus RTU ............................. 10
  Scenario 5: ION Meter as Modbus Gateway ........................ 10
- ION Meters as a Modbus Master ...................................... 11
  ION Modules for Modbus Master .................................... 11
  Multiport Serial Modbus Master .................................... 15
- ION Meters as a Modbus Slave ....................................... 18
  Using the ION Meter as a Modbus Slave ........................... 18
  Modbus Slave Module Settings .................................... 18

Additional Information

- ION Reference
- ION/Modbus Register Map document that applies to your meter
- www.ioserver.com (devices that support Enhanced Modbus/TCP)
- www.modicon.com (Modbus/TCP standard, Modicon Modbus Serial Communications Protocol documentation)
- www.modbus.org (SEMI E54-0997 standard)
Introduction

Modbus is a protocol used in industrial manufacturing. It was created to transfer control data between controllers and sensors using RS-232 serial ports. The Modbus protocol is widely used and supported on serial (RS-232 and RS-485) and Ethernet (TCP/IP) connections.

Modbus is a master/slave protocol where the master initiates transactions and the slaves respond with the requested data or action. Modbus masters are usually software programs, such as Distributed Control Systems (DCS). However, masters can also be devices such as remote terminal units (RTU), programmable logic controllers (PLC) or ION meters. Modbus slaves are devices such as PLCs, I/O monitoring devices, relays, software and ION meters.

ION meters, when used as Modbus master or slave devices, provide sensing for your Modbus network so you can quickly view and respond to power data and equipment status information.

Modbus RTU and Modbus ASCII
The Modbus protocol has two basic forms. The RTU or Binary form and the ASCII form. The ASCII form transmits all bytes using the ASCII character set ('0-9' and 'A-F'). The RTU form transmits all bytes in a binary format making the protocol faster and more efficient. Both forms are serial (RS-232/RS-485) protocols. Whichever form is used, both the master and the slaves must use the same form.

Modbus Plus
Modbus Plus is a proprietary Modicon protocol used in industrial networking systems. It uses token-passing peer-to-peer communications at a data transfer rate of one megabit per second (high-speed passing of groups of bits within a layer). The network medium is shielded twisted-pair cable.

Modbus/TCP
Modbus/TCP defines the packet structure and connection port (port 502) for the industry standard TCP/IP protocol. The structure of a Modbus/TCP packet is very similar to the Modbus RTU packet except that it has an extra six-byte header and does not require the cyclic redundancy check (CRC). Some ION firmware supports Modbus/TCP for direct communications with the meter, as well as for use in a Modbus gateway.

Modbus/TCP retains the Modbus RTU limit of 256 bytes to a packet. It is suggested that higher throughput is possible if this limitation is removed. This variant is called Enhanced Modbus/TCP but, so far, few devices have moved to support it.

NOTE

Some devices support multiple simultaneous Modbus/TCP connections. If you are trying to connect to one of these meters, it can take some time. Adjust your network timeout settings to accommodate this.

Modbus RTU over Ethernet
Your ION meter can use Modbus RTU to transport direct to a Modbus device over Ethernet.
The Modbus Message

There are a few variants of the Modbus protocol for use in different networks and situations but all use the same message structure. The most common Modbus variants are Modbus RTU, Modbus ASCII, Modbus Plus and Modbus/TCP. The Modbus message that a master sends to a slave contains these main pieces of information:

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave Address</td>
<td>Unit ID (from 1 to 247)¹</td>
</tr>
<tr>
<td>Function Code</td>
<td>Read from or write to registers</td>
</tr>
<tr>
<td>Data</td>
<td>16-bit words of various formats</td>
</tr>
<tr>
<td>Checksum</td>
<td>CRC-cyclical redundancy check</td>
</tr>
</tbody>
</table>

¹ Unit ID 0 (zero) is also allowed. This sends a broadcast message to all slave meters.

ION meters are preconfigured with a unit ID that you can change from the front panel of the meter or via software. This unit ID serves as the slave address that the master uses to determine which slave to communicate with.

The function code used is based on the variable type that a particular ION meter supports, and whether the ION meter is acting as a master or a slave.

Variable Types

The basic Modbus message building blocks are called variable types. Variable types group data into address ranges that perform certain functions (using function codes). For example, Coil registers have an address range from 00001 to 09999 and the data that makes up the message can be read or written to (Function 1, 5 and 15).

There are four main classes of Modbus data, or variable types, that support different function codes. Coil and input registers are single-bit registers used to indicate ON or OFF conditions. Input and holding registers are 16-bit registers used to store and retrieve data.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Supported Function Code</th>
<th>Address Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coils</td>
<td>Digital bits that can be read and written to</td>
<td>Function 1, 5, 15</td>
<td>00001 to 09999</td>
</tr>
<tr>
<td>Input Status</td>
<td>Digital bits that can be read</td>
<td>Function 2</td>
<td>10001 to 19999</td>
</tr>
<tr>
<td>Input Registers</td>
<td>16-bit integers that can be read</td>
<td>Function 4</td>
<td>30001 to 39999</td>
</tr>
<tr>
<td>Holding Registers</td>
<td>16-bit integers that can be read and written to</td>
<td>Function 3, 6 and 16</td>
<td>40001 to 49999</td>
</tr>
</tbody>
</table>
Function Codes

ION meters (acting as master or slave) use ION modules (Modbus Master Device, Modbus Master Mapping, Modbus Import, Modbus Export and Modbus Slave modules) to support the following function codes:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>ION master or slave function</th>
<th>ION module that supports the function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function 1</td>
<td>Read Coil Status</td>
<td>Master</td>
<td>Modbus Import, Modbus Master Device, and Modbus Master Map¹</td>
</tr>
<tr>
<td>Function 2</td>
<td>Read Input Status</td>
<td>Master</td>
<td>Modbus Import, Modbus Master Device, and Modbus Master Map¹</td>
</tr>
<tr>
<td>Function 3</td>
<td>Read Holding Registers</td>
<td>Master and slave</td>
<td>Modbus Import, Modbus Master Device, and Modbus Master Map¹</td>
</tr>
<tr>
<td>Function 4</td>
<td>Read Input Registers</td>
<td>Master</td>
<td>Modbus Import, Modbus Master Device, and Modbus Master Map¹</td>
</tr>
<tr>
<td>Function 5</td>
<td>Write to a Coil</td>
<td>Master</td>
<td>Modbus Export</td>
</tr>
<tr>
<td>Function 6</td>
<td>Write to a Holding Register</td>
<td>Master</td>
<td>Modbus Export</td>
</tr>
<tr>
<td>Function 15</td>
<td>Write to Multiple Coils</td>
<td>Master and slave</td>
<td>Modbus Export</td>
</tr>
<tr>
<td>Function 16</td>
<td>Write to Multiple Holding Registers</td>
<td>Master and slave</td>
<td>Modbus Export and Modbus Slave</td>
</tr>
</tbody>
</table>

¹ The Modbus Master Map module and the Modbus Master Device module work together, and reference the settings in Modbus Master Options module; you need all modules configured properly for this feature to work.

The maximum number of Modbus registers the module can read at once (per request) depends on the Modbus format and data register type. Modbus supports a combination of 16-bit data types. These data formats use one or two 16-bit words to encode signed/unsigned or integer/floating point numbers:

<table>
<thead>
<tr>
<th>Format</th>
<th>Type</th>
<th># of Modbus registers used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsigned 16-bit</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Signed 16-bit</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Unsigned 32-bit</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Signed 32-bit</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Unsigned 32-bit M10k</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Signed 32-bit M10k</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>IEEE Float¹</td>
<td>Floating point</td>
<td>2</td>
</tr>
<tr>
<td>Packed Boolean</td>
<td>Integer</td>
<td>1</td>
</tr>
</tbody>
</table>

¹ ION meters acting as Modbus masters support two versions of IEEE Float with different word orders: high/low = Big Endian, low/high = Little Endian. Big Endian/Little Endian is supported for all 32-bit formats by ION meters acting as Modbus masters.
Modbus Maps for ION Meters

There are two types of Modbus mappings available on ION meters: one is a fixed map and the second is a flexible map. The fixed map is useful for configuring parameters on the ION meter (slave) or allowing third-party software to access other ION modules. For more information on the Modbus fixed map, see your meter’s User Guide.

When a master sends a request to a fixed map on the ION meter (slave), the value is written to the corresponding mapped register on the ION meter. For example, the Modbus master sends “5” to register “44590” which changes the baud rate on COM2 to 19200—the baud rate is an enumerated parameter and the fifth enumeration is 19200.

ION meters also provide a flexible map that you can use for reading data. The flexible Modbus map lets you read various ION registers with Modbus master devices by correlating the Modbus register number with the address of the ION register (on the slave) you want to read. When a Modbus master requests to read a register, the corresponding ION register data is returned.

For more information on the Modbus flexible map for ION meters, see the Common Modbus Registers document and Appendix E of the ION7300 Series Modicon Modbus Serial Communications Protocol document.

NOTE

If you have Advanced security enabled, you must configure the Modbus Map Access register to allow write access for specific users. See the Security Options module description in the ION Reference. If you have Standard or Advanced security enabled on the meter, you can only read Modbus information from a slave module. You must disable Standard security to write data to a slave module. See the ION System Security technical note for more information.
**ION and Modbus in Networks**

An ION meter acting as a slave can make real-time data (and in some cases, historical data) available to Modbus masters using third-party software. Modbus masters can also write data to ION meters to change device configurations or initialize control actions.

You can use ION Setup or ION Enterprise software to collect data from and send data to Modbus devices directly. Similarly, the ION meter with Modbus master capability can collect data from a Modbus network and send it to ION Setup or ION Enterprise software for display and analysis. Using ION Setup or ION Enterprise software, you can configure these meters to read data from and write data to Modbus slave devices.

The following section describes different scenarios where ION meters and ION Setup or ION Enterprise software integrate with Modbus devices and networks.

**Scenario 1: ION Meters in a Modbus Network**

If you have third-party Modbus software, you can communicate with ION meters over Ethernet and serial connections. Most ION meters with Ethernet capability support Modbus/TCP on TCP port 502. There is no meter configuration required for a third-party master to communicate with an ION meter over TCP/IP.

You can also make a serial connection to an ION meter using third-party software. Set the communication port on the meter using the front panel of the meter.
Setting the serial communication from the ION meter to third-party software

1. Using the front panel of the meter, navigate to the communications port you want to use to connect to third-party software.

2. Set the protocol for this port to “Modbus RTU” and ensure the baud rate, unit ID, serial port and RS-232 or RS-485 settings are correct.
   Use ION Setup or ION Enterprise software to modify these settings for meters without a front panel display.

Scenario 2: Modbus Devices in an ION Enterprise Network

You can add a Modbus slave device to your ION Enterprise network using RS-232, RS-485 or Ethernet (shown below) connections.

Use the ION Enterprise Modbus Device Importer utility to configure your Modbus device (mapping information) and add it as a Device Type to the Network Configuration database.

**NOTE**

See the online ION Enterprise Help for more information on adding Modbus device types to ION Enterprise. You can also contact Technical Support about pre-made Device Integration Packages, which add a device directly into your system.

Once the device type is added, you can see your Modbus device in a drop-down menu in Management Console.

Adding a Modbus device to the ION Enterprise network


2. Right-click in the display window and select New > Serial Device on Direct Site, New > Serial Device on Ethernet Gateway Site or New > Ethernet Device, depending on your type of connection. The Device Configuration dialog box appears.

3. Use the drop-down menus or type the required information in the fields. Your Modbus device type appears in the Device Type drop-down menu.
Scenario 3: ION Meter as Modbus Master

As a master, the ION meter can aggregate data from multiple slave devices and then pass it to ION Enterprise or ION Setup for analysis. The ION meter as a master also gives you control of devices on a Modbus network with its write capability.

If the ION meter you are using is acting as a master, there are two communication links to consider when you communicate from a Modbus network (or device) to ION Setup or ION Enterprise software:

- **Between the hardware communications port on the ION meter and the Modbus network.** There are two link types, serial or Ethernet. Modbus Master over Ethernet using TCP/IP is not available on all meter types.
  - The serial link is a one-to-one relationship between the physical communications port on the meter (COM1, COM2, etc.) and the serial wiring that connects the meter to a Modbus network (RS-232 or RS-485).

  **NOTE**
  Most Modbus Master-enabled meters support only one serial bus of Modbus Slave devices. However, some meters offer multiple Modbus Master serial port functionality. See “Multiport Serial Modbus Master” on page 15 for more information.

- The TCP/IP link can connect up to ten devices to the Modbus Master. The connections are created by entering the IP address of the device you want to connect to and the port number (Modbus TCP/IP is port 502).

- **Between the ION meter and ION Setup or ION Enterprise software** — For Ethernet communications, the meter allows multiple TCP/IP “virtual ports” (i.e. 502, 7701, etc.) to connect to a single hardware port. On the meter, TCP/IP virtual ports indicate to the software which protocol is being used to communicate.

**Configuring the ION Meter to act as Modbus Master (serial)**

1. Using the front panel of the meter, navigate to the serial communications port you want to use to connect to the Modbus Slave devices.
2. Set the protocol for this port to “Modbus Master” and ensure the baud rate, unit ID, serial port and RS-232 or RS-485 settings are appropriate.

Use ION Setup or ION Enterprise software to modify these settings for meters without a front panel display.
The image below shows how ION Setup or ION Enterprise software and an ION meter (communicating over Ethernet) can integrate with a serial Modbus network.

**Configuring the ION meter to act as a Modbus Master (Ethernet)**

You must use ION Setup or ION Enterprise software to configure Modbus Master over TCP/IP. Your Modbus Master meter must have a physical Ethernet connection, be the correct model, and run a firmware version that supports this feature. You can enter up to ten unique IP addresses that belong to Modbus devices you want to master, assigned to virtual port 502, in the Modbus Master ION meter.
Scenario 4: EtherGate and Modbus RTU

EtherGate (Ethernet gateway) capability is built into all ION meters with Ethernet cards, except the ION7300 meter. With EtherGate, users can communicate over a network with any ION or Modbus-compatible device connected to an EtherGate meter via an RS-485 loop.

The EtherGate meter acts as an intermediary between the RS-485 devices (Modbus slaves) and the Modbus master, allowing the Modbus master to send and receive data over TCP/IP. In ION Enterprise, users can create an EtherGate site and communicate with a series of devices on the RS-485 loop.

For more information on EtherGate and ION meters, see The ION Meter as an Ethernet Gateway technical note.

Scenario 5: ION Meter as Modbus Gateway

Modbus Gateway capability is available on selected ION meters. With an ION meter acting as a Modbus Gateway, a Modbus master can communicate via the Ethernet using Modbus/TCP through the gateway meter to downstream serial devices using Modbus RTU.

The Modbus Gateway meter acts as an intermediary between Modbus slaves on a serial network and the Modbus master device, allowing data to be sent and received over Modbus/TCP.

For more information on using your ION meter as a Modbus Gateway, see your meter’s User Guide.
ION Meters as a Modbus Master

ION meters with Modbus master capability let you write data to (export) and read data from (import) Modbus slave devices. The ION meter (acting as a Modbus master) can read data on a Modbus network and act as a point of data aggregation. The data can be processed by the meter and sent out using other communications methods (email, ION Setup or ION Enterprise software, etc.). The meter can also send control commands or data directly to other devices on a Modbus network.

NOTE

Only one meter on a Modbus network can have the communications channel set to the Modbus Master protocol.

ION Modules for Modbus Master

Several ION modules work together to create Modbus master functionality on the meter. Your meter can have some or all of these modules, depending on the model and firmware version. See the ION Reference for more information on these and other ION modules:

- **Modbus Master Device Module**: The Modbus Master Device module reads data from a Modbus slave, which can be an ION meter or third-party device. This imported data can be used by other ION modules. A Modbus Master Device module uses settings from a Modbus Master Map module setup register to specify the Modbus format, scaling, and base address settings.

- **Modbus Master Map Module**: provides a common place to hold setup information for decoding a Modbus response. This information can be used by multiple Modbus Master Device modules.

- **Modbus Master Options Module**: maps any serial connection or Ethernet TCP connection from the Modbus Import, Modbus Export and Modbus Master Device modules to any serial communications port or unique IP address and port number.

- **Modbus Export Module**: The Modbus Export module writes data to a Modbus device. A Modbus master can send data (numeric, pulse and Boolean register classes) to an ION meter via Modbus. You can use this data to enable, disable, and reset metering functions, as well as change setup register values to configure the meter's operation.

- **Modbus Import Module**: The Modbus Import module reads data from a Modbus slave, which can be an ION meter or third-party device. This data can then be used by other ION modules. A Modbus Import module's setup registers specify the Modbus format, scaling, and base address settings.

NOTE

There are many Modbus Import, Modbus Export and Modbus Master Device modules available. The modules behave like Modbus controllers. However, each module can only communicate to a single Modbus slave device on a single communication connection.
Reading and Writing Data Using ION Enterprise

**NOTE**

Some legacy products have older variants of the Modbus Import and Modbus Export modules that contain connection information now configured in the Modbus Master Options Module. If so, enter the connection information into the appropriate registers in the Modbus Import or Modbus Export modules.

Reading Data from Modbus devices using the Modbus Master Device Module

1. Start Designer (ensure that Options > Show Toolbox is checked).
2. Navigate to the Modbus Master Options module. Right-click the module to edit the register values.
   - For serial Modbus Master, configure the Serial Connection values to match the communications port (e.g., COM2, COM3) being used to communicate with the Modbus slave devices.
   - For Modbus Master over TCP/IP, configure the TCP Connection values to match the IP address of the slave device and the port (e.g., 192.168.0.1:502).
3. Navigate to where you want to store your Modbus Master configuration (e.g., 3rd-Party Protocols > Modbus). Drag out a new grouping object from the toolbox, name it appropriately and double-click on your new grouping object. A blank workspace displays where you can keep your Modbus Master configuration.
4. Drag out a new Modbus Master Device module to use with your Modbus slave device. Right-click the module and configure the following registers:

<table>
<thead>
<tr>
<th>Register Name</th>
<th>Register Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Boolean Input</td>
<td>Set this register to ON.</td>
<td>Set to OFF to make the outputs N/A.</td>
</tr>
<tr>
<td>Read Now</td>
<td>Pulse Input</td>
<td>Link this register to set the module to Read Now mode.</td>
<td>If this is unlinked, module operates in Polling Mode and will request every second.</td>
</tr>
<tr>
<td>Connection</td>
<td>Enumerated Setup</td>
<td>Select the serial or TCP connection you want this module to use.</td>
<td>These connections are configured in the Modbus Master Options module.</td>
</tr>
<tr>
<td>Slave Addr</td>
<td>Numeric Setup</td>
<td>Enter the address of the Modbus slave device (1-255 accepted).</td>
<td>Make sure each device has a unique address.</td>
</tr>
<tr>
<td>Device Type</td>
<td>String Setup</td>
<td>Enter the type of Modbus slave device -- for example, 6200.</td>
<td>This register value must match the corresponding Device Type register in the Modbus Master Map module, for the map to be available to this module.</td>
</tr>
<tr>
<td>Slave Name</td>
<td>String Setup</td>
<td>Enter the name of the Modbus slave device -- for example, Submeter1.</td>
<td>The output value is in the format: &lt;label&gt;@&lt;slave name&gt;[value]</td>
</tr>
<tr>
<td>Outputs 1-32</td>
<td>Numeric Output</td>
<td>Link these to a variety of ION modules -- for example, a Data Recorder.</td>
<td>This value will be appended to the output registers.</td>
</tr>
</tbody>
</table>
5. Drag out a new Modbus Master Map module. Right-click the module and configure the following registers:

<table>
<thead>
<tr>
<th>Register Name</th>
<th>Register Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>String Setup</td>
<td>Enter the type of Modbus slave device. For example, 6200.</td>
<td>This register value must match the corresponding Device Type register in the Modbus Master Device module, for the map to be available to the module.</td>
</tr>
<tr>
<td>Device Map</td>
<td>String Setup</td>
<td>Enter the mapping information for this device. See the module description in the ION Reference for details.</td>
<td>This map (label, address, format and scaling information) can be used by multiple Modbus Master Device modules.</td>
</tr>
</tbody>
</table>

6. Link the output registers to desired modules (such as Data Recorders). The output values from the Modbus Master Device module are appended with a label and device name. The Data Recorder module understands these names, and will populate the ION database using them (e.g. kW@Submeter1).

7. In Vista, update your user diagram by dragging a new object from the Diagram objects toolbar, and configure it to best display your Modbus slave device data.

**Reading Data from Modbus devices using the Modbus Import Module**

1. Start Designer (ensure that Options > Show Toolbox is checked).
2. Navigate to the Modbus Master Options module. Right-click the module to edit the register values.
   - For serial Modbus Master configure the Serial Connection values to match the communications port (e.g., COM2, COM3) being used to communicate with the slave devices.
   - For Modbus Master over TCP/IP, configure the TCP Connection values to match the IP address of the slave device and the port (e.g., 192.168.0.1:502).
3. Navigate to where you want to store your Modbus Master configuration (e.g., 3rd-Party Protocols > Modbus). Drag out a new grouping object from the toolbox, name it appropriately and double-click on your new grouping object. A blank workspace displays where you can keep your master configuration.
4. Drag out a Modbus Import module.
5. Use the ReadNow input of the Modbus Import module if you want to setup a trigger source that activates a read (i.e. a pulse). If you do not link ReadNow, the module polls Modbus devices continuously.
6. Right-click the Modbus Import module to configure register settings.
   Configure the following setup registers as needed: Connection/COMM Port (if applicable), Slave Address, Register Address, Number of Registers read by the module, Format and scaling requirements. The supported Slave Address range (Unit ID on ION meters) for a Modbus device is from 1 to 247.
7. Link the output registers to desired modules (such as Data Recorders).
8. In Vista, update your user diagram by dragging a new object from the Diagram objects toolbar, and configure it to best display your Modbus slave device data.
Writing data to ION meters using the Modbus Export Module

1. Start Designer (ensure that Options > Show Toolbox is checked).

2. Navigate to the Modbus Master Options module. Right-click the module to edit the register values.
   - For serial Modbus Master, configure the Serial Connection values to match the communications port (e.g., COM2, COM3).
   - For Modbus Master over TCP/IP, configure the TCP Connection values to equal the IP address of the slave device and the port (e.g., 192.168.0.1:502).

3. Navigate to where you want to store your Modbus Master configuration (e.g., 3rd-Party Protocols > Modbus). Drag out a new grouping object from the toolbox, name it appropriately and double-click on your new grouping object. A blank workspace displays where you can keep your master configuration.

4. Drag out a Modbus Export module.

5. Link the Source inputs of the Export module to values that you want to export.

6. You must link WriteNow to initiate a write.

7. Right-click on the Modbus Export module to configure the setup register settings.
   - Set the Connection/COMM Port (if applicable), Slave Address, Register Address, Request Type, and Format registers and any scaling requirements. A Slave Address of zero (0) is reserved for broadcast messages. Broadcast messages are useful for control actions, such as synchronizing all the devices (only an approximate synchronization is possible due to signal latencies).

   **Tip**

   Use Designer to determine the ION module/register that you want to write to and then use the Common Modbus Registers document and Appendix E of the ION7300 Series Modicon Modbus Serial Communications Protocol document to find the corresponding Modbus register number. For protocols other than ION, consult the appropriate protocol documentation for your device.

8. In Vista, create and link an object that best displays your configuration.

Using ION Setup to Configure Modbus Master

1. Open ION Setup and connect to your meter in Basic Mode.

2. Open the Setup Assistant and navigate to the 3rd Party Protocols screen in the Communications folder.

3. On the Modbus Master tab, click Add to add a new slave device. The Modbus Device dialog appears.

4. Enter the information requested:
   - **Name**: This is the slave device name
   - **Label suffix**: This is the slave device group.
   - **Device type**: This is the device type of the slave device. It must match the device type given in the Device Type register in the Modbus Master Map module.
Connection via: This is the serial connection or Ethernet TCP connections through which you communicate with the slave device. To view the ports/IP addresses and Modbus protocol assigned to each connection, click Connections. The Modbus Master Connections screen appears with tabs containing connection information.

Slave ID: This is the slave ID, or slave address, that the meter uses to address packets to the slave device.

5. To perform more advanced configuration, connect to your meter in Advanced Mode and navigate to the relevant folder. To insert a new module, select Insert > Module. To edit module settings, double-click on the module in the right-hand pane.

The modules relevant to Modbus Master are: Modbus Master Device module, Modbus Master Map module, Modbus Master Options module, Modbus Import module and Modbus Export module. For more information on these modules, see the ION Reference.

Multiport Serial Modbus Master

Some meters have multiport serial Modbus Master capability. This allows the meter to master any available RS-232 / RS-485 serial buses of Modbus Slave devices on more than one serial port at the same time. Buses can be connected to either COM 1 or COM 2 only.

NOTE

The ION7550 RTU does not support multiport Modbus Master. The device cannot master on serial communication ports COM1 and COM2 at the same time.

Multiport serial Modbus Master functionality requires configuration of a special module (Modbus Master Options) and additional setup registers in three other modules (Modbus Import, Modbus Export, and Modbus Master Device).

See the ION Reference for more information on these modules.
In order for the Master to know on which serial bus a device resides, the Modbus Master Options module is used to map (or link) a connection to a meter serial communication port. All modules for the slave devices (Modbus Import, Export and Modbus Master Device) are then mapped to one of the connections.

The Modbus Master Options module’s four outputs indicate if each serial connection is actively being used by another ION module (Modbus Import, Export and Modbus Master Device).

See the example framework below for implementation details. The ION7650 meter, acting as Modbus Master, is communicating with the ION7330, acting as Modbus Slave. The ION7330 is wired via RS-485 to the ION7650 meter’s COM 2 port. The ION7330 meter’s Unit ID is 101.

![Diagram showing Modbus connections]

**Configuring the Meter**

Use ION Setup or the Designer component of ION Enterprise to configure your meter.

**Configure the Modbus Master Options Module**

Set the *Serial Connection* register to the meter communication port the loop of slave devices will use for communications. Choose None (default), COM1 or COM2. For Modbus Master over TCP/IP, set the *TCP Connection* register to the IP address of the Modbus slave device, specifying port 502.

**Configure the Modbus Import Modules**

All Modbus Import modules have a *Connection* enumerated setup register. This register maps the serial or TCP connection to a setup register in the Modbus Master Options module. Enter the slave device unit ID into the *Slave Addr* setup register.

**Configure the Modbus Export Modules**

All Modbus Export modules have a *Connection* enumerated setup register. This register maps the serial or TCP connection to a setup register in the Modbus Master Options module. Enter the slave device unit ID into the *Slave Addr* setup register.
Configure the Modbus Master Device Modules

All Modbus Master Device modules have a *Connection* enumerated setup register. This register maps the serial or TCP connection to a setup register on the Modbus Master Options module. Enter the slave device unit ID into the *Slave Addr* setup register.
ION Meters as a Modbus Slave

All ION meters have a unique unit ID. When acting as a slave, the ION meter’s unit ID serves as the slave address to which the master connects. These addresses must be in the range 1 to 255. The meter processes broadcast read requests (0) but does not reply to them; however, broadcast writes (0) are supported.

NOTE

A Modbus slave can only respond to requests; it cannot initiate them.

Most ION meters have pre-configured Modbus Slave modules. These can be accessed using Designer, inside the ION meter’s “3rd-Party Protocols” folder. If these pre-configured modules do not suit your needs, you can drag out new Modbus Slave modules or change the configuration of the existing ones.

Using the ION Meter as a Modbus Slave

You can use the Modbus protocols for real-time data communications on the meter’s serial, Ethernet, modem and Infrared ports. These hardware ports are controlled by ION communications (COMM) modules that exist in the meter’s firmware. First, configure the communications port(s) through which you want to transport the Modbus data. The meter can then transmit data from ION Modbus Slave modules. The Modbus Slave modules convert an ION meter’s data into Modbus format for Modbus master devices. Most meters that support Modbus Slave modules already have some pre-configured modules for common parameters such as power and energy values and power quality information.

Modbus Slave Module Settings

Once the communications port is configured to use Modbus, the data is available to a Modbus master device. The Modbus Slave modules are pre-configured to communicate specific power system parameters in a particular format. A sample configuration is shown below:

Sample of Factory Configuration

Set the COM port to the appropriate protocol

Communications Port

Data is available to Modbus master devices

Power Meter Module

Modbus Slave Module

IONmeter

Measured data is linked to the Modbus Slave module’s input

Modbus Slave module outputs data in Modbus format

Vln a 40011

© 2009 Schneider Electric. All rights reserved.
On some ION meters, when there are no input links, the output registers show the contents of the fixed Modbus address map as defined by the setup registers of the Slave Module. The values at the map address are copied to the output registers, starting at the address specified in the BaseAddr setup register, until each output register is filled. You must change the Format setup register to “Unsigned 16B Input Mode.”

You can also edit the setup registers of the Slave module if your Modbus master device requires data in a format different than the factory configuration or requires special addressing. Modbus Slave modules have the following setup registers:

<table>
<thead>
<tr>
<th>Setup Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
</tr>
<tr>
<td>Base Address</td>
</tr>
<tr>
<td>Scaling</td>
</tr>
<tr>
<td>IONInMinScale</td>
</tr>
<tr>
<td>IONInMaxScale</td>
</tr>
<tr>
<td>ModbusOutMinScale</td>
</tr>
<tr>
<td>ModbusOutMaxScale</td>
</tr>
</tbody>
</table>

**NOTE**

Settings for these registers (and defaults) vary depending on meter model and firmware version. See your meter’s User Guide.

For more information on using the Modbus Slave module, see the Modbus Slave module description in the ION Reference.

**Changing default Modbus configuration using ION Enterprise**

1. Open your meter in Designer.
2. Re-link a new or existing Modbus Slave module to any parameters.
3. Right-click near the center of the module to edit any of the registers.
4. Select **File > Send & Save** to save your changes to the meter.

**Changing default Modbus configuration using ION Setup**

1. Open ION Setup and connect to your meter in Advanced Mode.
2. Navigate to the Modbus Slave module folder. In the right-hand pane, double-click on the module you want to configure.
3. Select the Inputs tab to link source inputs to the module. Select the Setup Registers tab to configure the setup registers. To edit a register, select it and click **Edit**.
4. Click **Send** to save your changes to the meter.